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VERSION 4.4.2 RELEASE NOTES 
These release notes keep you informed about the latest features and changes available in Release v4.4.2 of 
ConnectNow Family Suite and Diocesan Suite. 
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ConnectNow Family Suite 

System-Wide 
 

Resolved Issues 

Various Typographical and Grammatical Errors Fixed  

We identified and fixed inadvertent typographical and grammatical errors occurring within applications in 
ConnectNow Family Suite. Corrections were made to various components of the user interface, such as, 
messages, notifications, and field labels. 
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Family Directory  
 

Updates and Enhancements  

Family List 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for a family, the system sometimes placed Address Line 2 
information on the same line as Address Line 1. Address labels are now formatted as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Family Details 

Organization Dropdown List Added to Family Details  

We added an organization dropdown list to Family Details. The new dropdown list enables users with 
access to multiple organizations to select the organization whose version of the family records they want to 
work with.  

 

 IMPORTANT 

The only organizations that show in the Organization dropdown list are those 
that the selected family or member is actively associated with and that the 
logged-in user has access to. 

  

Organization dropdown 
list 
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Member List 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for a member, the system sometimes placed Address 
Line 2 information on the same line as Address Line 1. Address labels are now formatted as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Member Details  

Organization Dropdown List Added to Member Details  

We added an organization dropdown list to Member Details. The new dropdown list enables users with 
access to multiple organizations to select the organization whose version of the member records they want 
to work with. 

 

Family Workgroups 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for families in a workgroup, the system sometimes 
placed Address Line 2 information on the same line as Address Line 1. Address labels are now formatted  
as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Organization dropdown 
list 
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Member Workgroups 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for members in a workgroup, the system sometimes 
placed Address Line 2 information on the same line as Address Line 1. Address labels are now formatted as 
follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Reports 

Funeral Report Modified to Show the Married Name Instead of the Maiden Name 

Previously, the Funeral sacrament report showed a married woman’s maiden name instead of her married 
family name. In response to customer feedback, we modified the report to show a woman’s married family 
name if she adopted her husband’s last name upon her marriage.  

Resolved Issues  

Family List 

‘All Organizations’ Filter Applied to the Family List Now Shows One Record Per Family 

Previously, when the user selected the All Organizations option to obtain a combined organizational view 
of families, records of families belonging to more than one organization were replicated by a factor equal to 
the number of organizations they were associated with. This issue misled users to believe that the records 
themselves were duplicates when they were not. We resolved this issue. When applied to the Family List, 
the All-Organizations filter now shows one record per family. That is, unless a duplicate record for a family 
exists in an organization’s database. 
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Member List 

Recipient’s Name on Mailing Labels Corrected  

Previously, the order in which the elements in a recipient’s name appeared on member mailing labels 
changed was not desirable. We modified the order so that the name of the labels now appears in this order: 
recipient’s title (for example, Mr. or Dr.) followed by the first name and then the last name. 

Sacraments 

Middle Name Column Added to Reconciliation Prep Export File 

Previously, the CSV file exported from the Reconciliation Prep grid contained no Middle Name column to 
capture members’ middle names. In response to customer feedback, we added a Middle Name column to 
the export file.  

Merge Fields Added to Notation Page in the Baptism Templates 

The Certificate of Baptism Full Parish Detail and the Certificate of Baptism Full templates includes a 
Notations page, which contains notations for other sacraments that may be received: 

• First Eucharist 

• Confirmation 

• Marriage  

• Religious Profession 

Previously, the notations were missing merge fields to show the dates and places of other sacraments 
received. We resolved this issue. For each sacrament listed on the Notations page, we added merge fields 
to show the sacrament details, such as, the date the sacrament was celebrated, the parish name and 
address, and sacrament location— if they are available in a member’s record.  

CSV File Now Includes Records Selected in the Sacraments Grid 

Previously when the user tried to export selected records from the Sacraments grid to a CSV file, the 
system exported all records instead of just the selected ones. We resolved this issue. Now, only the selected 
records are exported. If the user selects no records, all records are exported.  

Member’s Holy Orders Record Now Displays Expected Data 

Previously, when the user opened a member’s Holy Orders record and viewed data on any tab, closed the 
record, and then opened another member’s record, the system populated whatever tab the user was 
viewing with information on the Diaconate tab in the previously viewed record. We fixed this issue.  
The data shown on each Holy Orders tab is now unique to member and to the tab the user is 
currently viewing.  
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Family Workgroups 

Edit Workgroups Button No Longer Becomes Disabled After User Views Family Details 

We resolved an issue that caused the Edit Workgroup button  in the Workgroups panel to become 

disabled after the user clicked  in the Families in Workgroups grid to view a family’s details.  

Reports 

Sacraments Reports Contains Multiple Entries for Certain Members 

For some organizations, we resolved an issue that caused the same member to appear multiple times in the 
following sacrament reports: 

• Baptism 

• First Eucharist 

• Confirmation 

• Marriage 

  



Page 9 of 42 
ConnectNow Version 4.4.2 Release Notes_last updated January 9, 2018 

Religious Education 
 

Updates and Enhancements 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated parent, student, or leader address labels, the system sometimes placed 
Address Line 2 information on the same line as Address Line 1. Address labels are now formatted as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Resolved Issues 

Reports 

Populated Registration Forms No Longer Include Names of Deceased Children 

Previously when the user generated a Populated Registration Forms report, the report incorrectly 
showed the names of children whose member status in the family record was set to Deceased. We 
resolved this issue. 
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Tools 

Description of the ‘Copy Classes’ Option Modified for Accuracy 

Previously, the description provided for the ‘Copy Classes’ option was misworded and therefore inaccurate. 
The description included the word “Sessions”, which led users to believe that the action of copying a term’s 
classes also included copying the term’s session data, which was not the case.  

To clarify: a term’s session data cannot be copied. You must create session data from scratch first before 
using the Bulk Class Manager to copy classes.  

To prevent future confusion, we modified the description of the Copy Classes from Another Term option 
by removing the word “Session”, as shown in the following illustration: 
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Offering  
 

Updates and Enhancements 

Reports 

Contributions and Pledges 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for contribution statements and pledge statements, the 
system sometimes placed Address Line 2 information on the same line as Address Line 1. Address labels are 
now formatted as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Resolved Issues 

Funds 

User Edits to the Fund End Date Now Saved As Expected 

Previously, after the user saved an edit to the fund end date, the system appeared to save the change but 
did not. We fixed this issue.  

Posting 

Red Text Removed from Non-Error Message 

Previously after closing a quick-entry batch, users were presented with a message in red text, which 
informed them that the system successfully closed the batch. Users reported finding the red text misleading 
because it gave the impression that the system experienced an error when, in fact, it had not. To prevent 
further confusion, we changed the color of the message from red to green. 
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Intermittent Timeout Error for Quick Entry Batches Resolved 

Previously, users occasionally experienced a timeout error when trying to open and enter data into quick 
entry batches. Although an intermittent issue, we determined that these errors typically occurred if users 
were performing these tasks when server usage was high. We improved the efficiency of the quick entry 
posting process to prevent it from being negatively impacted when users’ demands on server resources 
were high.  

Timeout Error Experienced When Attempting to Open the Quick Entry Posting Page Resolved  

Previously, users in large organizations or in organizations with large quick-entry batches experienced a 
timeout error when attempting to open the Quick Entry Posting page. We fixed the cause of this error. 

Reports 

Contributions 

E-Statements ‘Processing Request’ Error Fixed  

We resolved an issue that caused a ‘processing request’ error message to occasionally display after the user 
attempted to generate E-statements by clicking the Generate E-statements button.  

‘Include $0 Contributions’ Checkbox Works As Expected 

Previously when the user selected the Include $0 Contributions checkbox, the system incorrectly 
excluded from the Givers grid all donors who had zero-dollar ($0) contributions only. As a result, users 
could not generate contribution E-statements or paper statements for those donors. The Include $0 
Contributions checkbox now works as expected. When the checkbox is selected, the system now correctly 
filters the Givers grid to include givers with zero-dollar (0$) contributions only.  

Member Option for E-Statement Generation Disabled 

Previously in the Contribution Source group, Member was shown a selectable option even though 
functionality for generating E-statements for members has not been implemented yet. We will add  
the ability to generate E-statements for members in a future release.  

To prevent future confusion, we modified the system’s behavior as follows: 

• If you select Electronic Statements as the delivery method, the Member option for Contribution 
Source is disabled (grayed out).  

• If you select the Member option for the Contribution Source, the Electronic Statements option is 
disabled (grayed out).  

The system will behave as described above until E-statements for members is an available feature. Thank 
you for your patience in this matter. 

Negative Contributions Now Include in Calculation of Contribution Totals 

Previously, the Contribution Statement did not include negative contributions in the calculation of 
contribution totals if those contributions did not have a positive contribution to offset them. We fixed this 
issue. Negative contributions that do not have an offsetting transaction to cancel them out are now included 
in the calculation of the contribution total.  
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Ministry Scheduler 
 

Updates and Enhancements 

Label Format Modified to Provide Space for Two Address Lines 

Previously when the user generated address labels for ministers and families, the system sometimes placed 
Address Line 2 information on the same line as Address Line 1. Address labels are now formatted as follows: 

• If information is provided in the family’s record for Address Line 1 and Address Line 2, the Address Line 
1 and Address Line 2 information appear on separate lines. For example: 

John Smith 
123 Stadium Blvd. 
Apt. # 45 
Ann Arbor, MI 48108 

• If no information is provided in the family’s record for Address Line 2, the address appears on two lines. 
For example: 

John Smith 
123 Stadium Blvd. 
Ann Arbor, MI 48108 

Resolved Issues 

Scheduling 

Controls Added to Ensure Deceased Members Are Not Scheduled  

We added controls to ensure that the auto schedule does not schedule any minister whose status is set to 
Deceased. Only members with a status of Active or ActOther are eligible for scheduling. 

Reports 

System No Longer Stuck on Loading Spinner on Reports Page in Chrome Browser  

Previously when setting the Date Range filter for a report, if a user selected a start date that was after the 
currently shown end date, the system became stuck on the loading spinner with no error message displayed. 
This problem, which was experienced in the Chrome browser only, was fixed.  
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Tuition  
 

Resolved Issues 

Invoices 

System Now Allows Users to Delete Invoices with No Associated Payments 

Previously, users could not delete an invoice to which payments had been applied and then later deleted. 
We resolved this issue. If an invoice has no payments associated with it, the system lets users delete it. 
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Diocesan Development 
 

Resolved Issues 

Donor Reports 

Donor Name Search Improved 

Previously, the names a user expected to see were missing from the results of a donor name search. We 
determined that the search parameters were too restrictive, which sometimes caused expected names to be 
excluded from the results. We expanded the search parameters to increase the likelihood of better donor 
name matches.  

‘Timeout Expired’ Error Resolved 

We resolved an issue that caused the system to run slowly and then experience a timeout error when 
attempting to generate a contribution statement. 

User-Specified Font for Body of Statement Text No Longer Changed 

Previously when contribution statements were exported to PDF, the system changed the user’s font selection 
for the body of statement to Times New Roman. We fixed this issue. The system no longer defaults the font 
selection to Times New Roman. 

Online Giving Management 

Transmission Errors Caused by Routing Numbers Starting with Zero Resolved 

We resolved an issue that caused the Online Giving system to experience an error when attempting to 
process transactions coming in through Online Giving Management that referred to a routing number 
containing a leading zero (0).  

Funds 

Clear Button for the Datepicker Calendar Now Working As Expected  

Previously on the Fund Management page, when the user clicked the Clear button for the datepicker 
calendar to clear the date entered into the Start Date or End Date field, the system did not remove the 
date. We fixed this issue. 
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IQ 
 

Resolved Issues  

Process for Creating a Family Workgroup from IQ Results Now Works As Expected 

Previously, the Create Family Workgroup process sometimes did not work as expected. Occasionally, the 
results set was empty, or the workgroup itself was not created. We resolved this issue. 

Column Values Converted from Integer to Decimal Type 

To maintain the required accuracy in reporting for financial calculations, we converted the Total Pledged 
to Fund and Amount Over Goal fields (located in the Fund > Organization Summary group) from 
integer type to decimal type. 

Queries Against Secure Fields Now Working As Expected  

We resolved an issue that prevented users from being able to successfully run queries against member 
Secure Fields. The fields are accessible to any diocesan staff that have an assignment to the diocese and 
have the Has Secure Field Access permission enabled for that assignment in their staff record. 
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Administration 
 

Updates and Enhancements  

Organizations 

‘Foundation’ Option Added to Organization Type Dropdown List 

Users reported that the system provided no way for them to identify an organization as a foundation. In 
response to user feedback, we added a Foundation option to the Organization Types dropdown list in 
Organization Details.  

Follow these steps to set the organization type to foundation: 

1. Click  to open the Organization Details window. 

2. In the Organization Type dropdown list, select the Foundation option, as shown here: 

 

3. Click  to save the selection. 
  



Page 18 of 42 
ConnectNow Version 4.4.2 Release Notes_last updated January 9, 2018 

Manage Staff 

‘All’ Option Added to the Member Status Dropdown List in the Advanced Filter Group 

As shown below, we added an All option to the Member Status dropdown list in the Advanced Filter 
group. Selecting this option lets you display all your staff in a single list regardless of their member status.  

 

‘Show End-Dated Staff’ Filter Added to the Advanced Filter Group 

As shown below, the Advanced Filter group features a new filter, labeled Show End-Dated Staff:  

 

The filter is a simple checkbox control that lets you filter the Staff List to show the names of deleted staff 
and staff with assignments completed in the past (the date in the Release Date column is in the past).  
The checkbox control has two states: 

Note 

Click  to save the option you select as the default or your favorite. 

• Selected (checked): shows the names of deleted or inactive staff (those with assignments that were 
completed in the past).   

• Deselected (not checked): shows the names of staff with assignments having no end date and with 
assignments having an end date in the future.  
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Format and Functionality of the Position Filter Modified   

We made the following changes to the Position filter on the Staff List toolbar: 

• Previously, the filter listed positions in a dropdown list format, which allowed you to make one filter 
selection only. We converted the filter to a dropdown list with checkbox options, which allow you to filter 
the Staff List using a combination of filters.   

As shown in the following illustration, each Position filter has its own checkbox control. To apply the 
filters, simply select the desired checkboxes and then click your mouse anywhere outside the  
dropdown list.  

 
The Position filter options are sorted in ascending order in the following sequence: 1) special 
characters, 2) numerals, and 3) letters. Note that after you select multiple filters, they appear as a group 
at the top of the Position dropdown list so that you can see which filters are applied to the Staff List:  

 

• Under the Position dropdown list, we added a Clear All link. When you want to completely clear the 
grid of any applied filters, simply click this link. Note that if you leave and then return to the Staff List 
page, the system automatically clears any filters you selected. 

• We also added a checkbox, labeled Search Only Primary Positions. This checkbox lets you apply a 
secondary filter to the selected Position filters. When this secondary filter is applied, the Staff List grid 
shows only those staff who have the selected positions designated as “primary” in their records.  
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Member DUID Information Added to the Member Search Modal  

To assist you with quickly locating the right member to add as new staff, we added Member DUID 
information to the Member Search modal. The modal, shown below, opens during the search phase 
of the Add New Staff process. 

Note 
You may need to click and drag the horizontal scroll bar to bring the Member DUID 
column into the viewing area. 

 

Duplicate Member Records No Longer Appear in ‘Add New Staff’ Search Results Set 

We added controls to prevent duplicate member records from appearing in the Add New Staff search 
results set. The process now returns a list of unique member records. 
  

Horizontal Scroll Bar 
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Organization’s City Name Added to the Assignments Dropdown List 

Occasionally, a staff user may hold assignments in organizations with the same name. To help you quickly 
distinguish between assignments, we added the organization’s city name to the Assignments dropdown list 
in the staff record. As shown in the illustration below, the city name follows the name of the organization:     

 

Added Ability to Save Selected Advanced Filter Option As a Favorite 

When selecting an option for any one of the following filters in the Advanced Filter group, you can now 
save the selected option as a favorite (the default): 

• Member Status 

• Assignment (Primary or Non-Primary) 

• Show End-Dated Staff 

To mark an option as a favorite: 

1. Select the option from the filter’s dropdown list. Then, click this icon to the right of the filter: .  

The system displays a message to inform you that your selection was saved as the default. 

2. Click  to dismiss the message.  

Note that the selected option is now the new default for the filter. If you apply the filter to the Staff List grid 

and then click  (Reset Advanced Filters to Defaults), the filter resets to your default (favorite) selection. 
  

Name of organization, city name: primary position 
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Address Tab in Staff User’s Member Details Now Visible to Diocesan Administrators Only 

In response to customer feedback, we removed the Address tab from Member Details so that it is no 
longer visible to parish users. Some parish users reported confusion about whether the address shown 
belonged to the family or the member. The tab shows the member’s address. However, to prevent future 
confusion, the tab is now visible to diocesan administrators only. 

Text in Position Field Now Displayed As a Link If the Staff Member Holds Multiple Positions 

If a staff member holds multiple positions in the organization, the text appearing in the Primary Position 
column is now displayed as a link. As shown in the following illustration, placing your mouse on the link 
(without clicking) opens a pop-up window that shows you other positions held by the member.    

 

If the staff member holds one position only, the position shown in the column is displayed in plain text: 

 

CSV Export File Now Shows Additional Positions Held by Staff 

We added a new column, labeled Additional Positions, to the CSV export file. This column, which appears 
after the Primary Position column, shows additional positions (that is, those not marked as “primary”) 
held by staff members.  
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Merge Families 

Member and Family DUIDs Added to Merge Family Records Page 

We added the Member DUID and Family DUID to the Merge Family Records page. The DUIDs are 
provided to assist you with identifying members and families you may want to merge. As shown in the 
following illustration, the DUID is located next to the family name and each member name listed in the 
Permanent and Duplicate Family Member groups and in the What to Do dropdown lists. The extra 
information provided by DUIDs will, in most cases, help you make faster and more accurate merge decisions. 
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Resolved Issues 

Lookups 

Member Lookup Table for Religion Now Updated As Expected with Merged Lookup Values 

Previously, if the diocese merged a lookup value for Religion, the system sometimes did not update the 
Religion dropdown list in Member Details with the change. We resolved this issue. After a Religion lookup 
value is merged, the Religion dropdown list in member records consistently reflects the change, and any 
record using the merged value is updated accordingly.  

Manage Staff 

Removing a User’s Giving History Permission Now Blocks Access to Family Giving History 

Previously users whose ConnectNow Offering > View permissions were disabled could access a family’s 
giving history information from within ConnectNow Family Directory. Such access should not have been 
allowed. We added controls to block users who lacked such permissions from viewing a family’s giving 
history.   

Filters Applied to Staff List No Longer Reset After the User Opens a Staff Record 

Previously if the user applied any of the filters (for example, rolodex and Advanced) to the Staff List and 
then opened and then closed a staff member’s record, the system reset the filters to the default values 
when it should not have. We fixed this issue.  

Assignment Shown in Primary Position Column Now Correct 

The Primary Position column shows the staff member’s primary assignment in the organization listed in the 
Organization column. Previously, the position shown was sometimes incorrect. We resolved this issue.  

Organizations 

Organization Administrators Can Edit Any Organization to Which They Have Access Permissions 

Previously diocesan administrators were permitted to edit the information for licensed organizations only.  
We removed this restriction. Users with Diocesan Admin rights can now edit any organization to which they  
have access. 
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Diocesan Suite 

Census 
 

Updates and Enhancements 

Family Details 

MLNA, ‘Do Not Call’, and ‘Do Not Solicit’ Checkbox Controls Added to the Family Record 

In response to customer requests, we added the following checkbox controls to the family record 
(Family Details): 

• MLNA (Moved, Left No Address) 

• Do Not Call 

• Do Not Solicit 

The checkboxes are in the lower-right corner of the family record. They are visible only to users with an 
assignment to the diocese and–at a minimum–Family Directory > View access rights. 

Diocesan Notes Section Added to the Notes Tab 

We added a new section, labeled Dio Notes, to the Notes tab in the family record. Because of its 
confidential content, the note section is visible only to users who have an assignment in the diocese and 
Family Directory > View permissions tied to their login credentials. Users who have edit rights for an 
assignment can also edit the content in the Dio Notes section.  

Church of Registration Field Converted to Dropdown List 

Previously, the Church of Registration field in the family record was a fixed field that showed the family’s 
organization of registration. As shown below, we converted the field to a dropdown list that contains the 
names of organizations the logged-in user has View > Add/Edit permissions to:  

 

The new dropdown list provides a quicker way for a user to change a family’s organization of registration: 
simply by selecting the desired organization from the list. Note that, like all other changes to a record, an 
organization change can only be made after the user clicks  to put the record in edit mode. 
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Member Details 

Secure Information Feature Added  

As shown in the illustration below, this release introduces a new tabbed area to Member Details, labeled 
Secure Information.  

 

The Secure Information tab is visible in an organization’s member records only if the feature is enabled 
for the diocese. The tab accommodates up to 10 custom fields into which authorized staff can add sensitive 
personal information to member records. A Notes field, where staff can type supplementary information, is 
also provided.   

Secure fields are not encrypted. Because the information on the tab is regarded as highly sensitive, only 
those staff meeting these requirements can see the tab and view and edit its contents: 

Note 
Users with Read access to the SQL database can also view Secure Information fields.  

• Have an active assignment to the diocese 

and 

• Have the Secure Field Access permission selected for the active assignment in their staff record. 

It is the diocesan administrator’s responsibility to enable the Secure Information feature, define the type of 
information to be collected, and assign permissions. See “Setup Page for Secure Information Added” for 
instructions on performing these administrator tasks.  

  

The Secure Information 
tab can contain up to 10 
custom fields plus a Notes 
area for more details. 
 
Secure fields are not 
encrypted. Because the 
fields may contain sensitive 
personal information, only 
authorized staff can see  
the tab itself and view/edit 
its contents. 
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Resolved Issues 

Family Details 

Staff with Edit Permissions in an Organization Can Now Edit the Organization’s Data Externally  

Previously if staff users with Family Directory View > Add/Edit permissions to multiple organizations tried to 
edit a family record not owned by the organization they were logged in to, the system disabled certain fields, 
which prevented them from being edited. To get around the problem, users had to switch to the 
organization owning the record. We resolved this issue. Users with View > Add/Edit permissions to an 
organization can now edit that organization’s family data externally. They no longer need to switch to the 
organization that owns the data. 

Member Details 

Staff with Edit Permissions in Multiple Organizations Can Now Edit Unowned Member Records 

Previously if staff users with Family Directory View > Add/Edit permissions to multiple organizations tried to 
edit a member record not owned by the organization they were logged in to, the system disabled certain 
fields, which prevented them from being edited. To get around the problem, users had to switch to the 
organization owning the record. We resolved this issue. Users with View > Add/Edit permissions to an 
organization can now edit that organization’s member data externally. They do not have to switch to the 
organization that owns the data.  

Family Workgroups 

Family Workgroups Added in Desktop Family Directory Now Visible in ConnectNow 

Family workgroups added in desktop Family Directory are now visible in ConnectNow Family Directory where 
they can be modified and managed as desired. Previously, the desktop application failed to transfer data for 
newly added workgroups to the ConnectNow system. 

‘Add Families’ Search Now Returns One Record Only 

Previously, if a family belonged to multiple organizations, a search for that family during the Add Families 
process returned a record for each organization the family belonged to. We revised the search process to 
return one family record only.  

Member Workgroups 

‘Add Member’ Search Now Returns Owned Organization’s Member Records Only 

Previously, if a member belonged to multiple organizations, a search for that member during the Add 
Member process returned a record for each organization the member belonged to. We revised the search 
process to return one record only.  
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Diocesan Development 
 

Resolved Issues 

Imports 

Trailing Commas in Lockbox 8 Import File No Longer Cause Failed Import 

Previously if the user tried to import a Lockbox Type 8 file that contained trailing commas (inserted to 
indicate blank fields), the import process failed. We resolved this issue. 

Funds 

Start and End Dates for a Fund No Longer Disappearing 

We resolved an issue that caused the Start and End dates for some funds to disappear. 
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Administration 
 

Updates and Enhancements  

Manage Staff 

‘Unknown’ Option Added to Member Status Filter’s Dropdown List  

As shown below, we added a new option, labeled Unknown, to the Member States filter in the 
Advanced Filter group. Selecting the Unknown option lets you filter the Staff List to show only those staff 
whose member status is unknown or null: 

 

Format of the Position Filter on the Staff List Toolbar Changed   

The format of Position filter on the Staff List toolbar was changed from a dropdown list allowing one filter 
selection only to a dropdown list allowing multiple selections. The filter options are sorted in ascending order 
in the following sequence: 1) special characters, 2) numerals, and 3) letters. 

Each Position filter has a separate checkbox. To apply one or more filters, simply select the desired 
checkboxes, as shown below:  
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Note that when multiple filters are selected, they are shown at the top of the Position dropdown list and 
followed by an alphabetical listing of options that have not been selected.  

To clear all selected filters, click the Clear All link under the dropdown list (see previous illustration). If you 
leave and then return to the Staff List page, the system automatically clears any previously selected filters. 

If you want to view only those staff who hold the selected positions as their primary one, select the Search 
Only Primary Positions checkbox (see the previous illustration). 

Assignment Filter Added to Advanced Filter Group 

As shown below, we added a new filter, labeled Assignment, to the Advanced Filter group:  

 

Applying the Assignment filter to your Staff List enables you to view staff records by assignment type. The 
filter has three assignment type options: 

Note 

Click  to save the option you select as the default or your favorite. The option will then 
appear first in the dropdown list. 

• All: shows primary and non-primary assignments. 

• Primary: shows primary assignments only. 

• Non-Primary: shows non-primary assignments only. 
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Module Settings 

Setup Page for Secure Information Added 

In this release, we added a tabbed area to Member Details, labeled Secure Information (for a description 
of this feature, see “Secure Information Feature Added”). Because of the personal and sensitive nature of 
the data that may be collected, the Secure Information feature is subjected to levels of protection designed 
to safeguard member data and privacy. At the highest level, the feature itself is disabled. Therefore, before 
any organization in the diocese can use Secure Information, the diocesan administrator (a user with 
Diocesan Admin permissions) must enable it. At the field level, the diocesan administrator defines the data 
to be collected and determines exactly who can view and modify that data. 

We added a section to the Module Settings page to enable you to set up the Secure Information feature. 
Use the following steps to set it up for your diocese.  

Note 
You must be logged in as an administrator and have Diocesan Admin permissions to 
perform these steps.   

Step 1: Enable the Secure Fields Feature  

1.  Click  to display the Module Settings page. 

2. In the Census group, select the Secure Fields option to display the Census > Secure Fields setup in 
the right panel. 

By default, the Secure Fields feature is disabled. 

3. As shown below, select the Enabled option: 

 

Then, click . 

The Secure Fields feature is now enabled for the dioceses.  

4. Go to Step 2. Assign Labels to Secure Information Field Labels, which follows, to define the information 
to collect. 
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Step 2. Creating Labels for Secure Information Fields 

As a user with Diocesan Admin permissions, you can create custom fields so that you can collect specific 
data about your members on the Secure Information tab in Member Details.  

The Secure Information tab can accommodate up to 10 secure fields. In this step, you will create labels 
for the fields.    

1. In the Secure Fields Labels section, type a label for each field.  

Note 
The first secure field accepts a date only, but you can define any label you want for  
the field. For example, Graduation Date. 

If you leave a field blank, the field does not appear on the Secure Information tab in 
Member Details. 

2. When done, click .   

The labels you defined appear on the Secure Information tab in each member’s record.  

Only authorized staff can access secure fields. To provide authorization, go to “Step 3: Give Diocesan 
Staff Permission to Access Secure Information.” 

Step 3: Give Diocesan Staff Permission to Access Secure Information  

Secure fields in Member Details are not encrypted. Only authorized staff can view and change the fields.  
Note 

Users with Read access to the SQL database can also view Secure Information fields.  

To provide access, do the following:  

• Give the staff member an active assignment to the diocese.  

and 

• For the active assignment, enable Secure Field Access permissions in the staff member’s record. 

Step-by-step procedures for performing these tasks are provided in the Administration Help. To access the 
Help, open the Administration module, and then select the HELP link in the upper-right.  
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Merge Families 

Merge Family Queue Grid Updated 

We made the following changes to the Merge Family Queue grid:  

• Added a new column, called Status, to provide the status of each merge record listed in the grid.  
A record has one of these types of status: 

 Pending: indicates that the record is waiting to be processed in the overnight merge.  
 Failed: indicates that the system experienced an error and could not merge the record. 
The status types are displayed as links. As shown in the following illustration, positioning your mouse on 
a link (without clicking) opens a pop-up window where you can view additional status information:  

 

• For merges involving a master family, identified the merged duplicate families.  

The grid lists the master family record and groups it with associated duplicate records. Clicking  to 
the left of the master record opens the group to show the merged duplicates. The duplicate records are 
listed in the order in which the user added them to the master family record, and the word “Duplicate” is 
appended to clearly identify them as duplicates. 
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Merge Family Records Process Updated to Enable Multiple Family Merges 

We updated the Merge Family Records process to enable you to merge up to five duplicate families 
simultaneously. The following instructions show you how: 

Note 
The Merge Families button is visible only to staff users with Merge Family  
Access permissions tied to their login credentials. 

1. Click . From the dropdown list, select the Merge Family Records option to open the 
Merge Family Records page: 

 

2. In the Family DUID Search fields, type the Family DUIDs of the families you want to merge: 

• Permanent Family: Family DUID of the family you want to keep. 

• Duplicate Family ID: Family DUID of the duplicate family. 

Then, click . 

If the system locates both Family DUIDs, it displays information for the permanent family and potential 
duplicate records at the bottom of the page. 

3. Review the search results. Then, for each record listed in the Duplicate Family Members group, 
select one of these options from the What to Do list: 

• Add as New: adds the member’s record to the permanent family’s record. 

• Merge with: removes the duplicate record by merging it with the permanent family’s record. 

4. In total, you can merge up five family records. For each additional record you want to merge, repeat  
the following: 

a) Type the Family DUID in the Additional Duplicate Family DUID field. Then, click . 

The application searches for the Family DUID. If the system locates the Family DUID, it displays the 
associated records at the bottom of the page. 

b) Review each record listed in the Duplicate Family Members group and select the appropriate 
What to Do option (described in Step 3). 
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5. When ready to merge all records, click . 

The system creates merge records for each Permanent-Duplicate pair and places the pending merge 
records into a queue to await processing in an overnight batch job.  

Note 
The system processes multiple family merges in the order in which you add the duplicate 
records to the permanent family. If any merge in the group fails, the system stops all 
subsequent merges until you resolve the issue causing the record to fail to merge. Failed 
merges are flagged as “Failed” in Status column in the Merge Family Queue grid (see 
“Merge Family Queue Grid Updated” for details). 

6. If desired, you can review pending records before they are merged. To do this, click  
and select the Merge Family Queue option. Pending records are shown in the grid. 

Merge Family Report Updated 

The Merge Family Report was updated to provide more information about completed merges. We added 
these details to the report: 

• First and last name of the staff member who initiated the merge. You can find the staff member’s name 
at the bottom of the report.   

• Member DUID of each merged member. 

• Name suffix (for example, Jr.), if specified in the merged member’s record. 

Reports 

Reports Section Added 

We added a new section, labeled Reports to the Administration module. In this release, the Reports 
section features two new reports, available only for users with the Diocesan Admin permission enabled: 

• Access Rights Export 

• Clergy Summary  

Access Rights Export 

The Access Rights Export report enables diocesan administrators to export an Excel (.xlsx) file that lists the 
names of staff in selected organizations and shows their assignments and associated access rights. The 
report is designed to help administrators better manage access rights of staff in the organizations they 
oversee. For example, the information can be used to determine whether certain staff need permissions 
added or removed and whether organization administrators are following the policies of the diocese when 
granting access rights to their staff users. 

The report setup is presented within a tabbed interface. Using the following steps, an administrator can 
quickly advance through the setup and create an Access Rights Export file:  

1. Click  to display the Administration Reports page (see previous illustration). 

2. In the left panel, select Staff > Access Rights Export. 
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3. On the Organizations tab, select the organizations containing the staff you want to include in the 
report. 

Note 

Clicking  opens a top-level organization’s group to display individual organizations  
within the group. You can select the checkbox next to each organization whose staff you 
want to include in the report. 

Selecting a top-level organization selects all organizations within the group. To exclude 
specific organizations, deselect their checkboxes. 

4. Click  or Next to advance to the Positions tab. Select the positions to which staff members 
must be assigned.  

5. Click  or Next to advance to the Options tab.  

6. If you want the export file to include access rights assigned on the Diocese Directory & Web 
Solutions tab in the staff record, select the Include Diocese Directory & Web Solutions checkbox.  

7. Click . 

The AccessRights.xlsx file is downloaded to your computer. 

Clergy Summary Report 

Designed for diocesan administrators, the Clergy Summary is a custom report that provides the following 
information for selected clergy: 

• Name 
• Date of birth/Date deceased 
• Names of mother and father 
• Date and place of baptism and name of celebrant 
• Diaconate/Ordination date and place 
• Date dismissed from clerical state 
• Home and work addresses 
• Assignment history, including place of assignment, primary position, and term dates. 

Follow these steps to set up a report: 

1. Click  to display the Administration Reports page (see previous illustration). 

2. In the left panel, select Clergy > Summary. 
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3. To set up the report, complete the following: 

Note 
Based on what you need to know, use the report filter options to specify the clergy records 
to include in the report. With each filter selection, the Clergy grid updates to show the 
names of individuals matching your filter criteria. 

a) In the Data Options group, select the type of clergy (for example, priests) to include in the report. 
Then, select a Status option. 

b) If you want to include only the clergy whose assignments have no end date, select the Active Staff 
Assignment Only check box.  

c) In the Report options group, select how you want to organize the information in the report: 

 Sorting: specifies the order in which the individual records in the report are arranged: 

o Last Name Ascending: in alphabetic order from A to Z. 

o Last Name Descending: in reverse alphabetic order from Z to A.  

o Member DUID Ascending: in numeric order from the smallest to largest number. 
o Member DUID Descending: in numeric order from the largest to smallest number. 

 Assignments: specifies the order in which assignments are listed in the Assignment History 
section of the report: 

o Newest: in chronological order from the most recent to the least recent. 

o Oldest: in reverse chronological order from the least recent to the most recent. 

d) In the Clergy group, select the individuals you want to include in the report. 

Note 
To select all individuals in the grid, select the checkbox in the header (to the left 
of the Last Name column), and then select the Select all records link. 

4. To generate the report, click . 

The report opens in the Report Viewer. Each page contains a single clergy record. Use the Page buttons 
in the toolbar to page through the records in the report. 
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Resolved Issues 

Organizations 

Organization Administrators Can Now Edit Any Organization to Which They Have Access 

Previously, the system required an organization to be licensed before it permitted users with Diocesan 
Admin access rights to edit the organization’s information. We removed this restriction. Users with Diocesan 
Admin rights can now edit any organization to which they have access. 

Manage Staff 

System Now Saves Edits to a Staff User’s Member Details Record  

Previously, the system did not save edits to a staff user’s member record if the Role field in the record was 
not set to one of the following: Head, Husband, or Wife. We resolved this issue. 

‘Clear Filter’ Button No Longer Disappears After the User Changes Organizations 

We fixed an issue that caused the Clear Filter button  to disappear from the Staff List toolbar if the user 
applied the Advanced filter to the Staff List grid and then changed the organization view. The Clear Filter 
button is now retained after a user changes the organization view.  

Merge Families 

Old Failed Merge Records Removed from Merge Queue 

In the initial 4.4.2 release, the Merge Family Queue grid was updated to show records that failed to 
merge (Status = Failed). An unintended result of this change was that the grid showed every failed record, 
including old records whose merges were eventually completed successfully. In a subsequent update, we 
removed these old records whose merge failures were successfully completed from the grid. We also set the 
default sort order on the Date Merge Created column to descending so that the most recently processed 
records appear first. 

Timeout Error Experienced When Opening the Merge Family Queue Page Resolved 

We resolved an issue that caused the user to experience a timeout error when attempting to open a Merge 
Family Queue page that contained a large set of data.   
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Subsequent Updates to the 4.4.2 Release 
We strive to ensure a problem-free version update. Nevertheless, some issues occasionally arise after a 
major release. We fix such issues immediately in subsequent updates to the software. The following tables 
list the issues that were encountered in the v4.4.2 release that were quickly resolved in subsequent updates. 
Each entry in the tables provides a link to the release note item, presented earlier in this document. 

Table 1. Issues Resolved in the v4.4.2.63 Update 

Module Issue Description Update 

Diocesan Development DIO-1047 System Times Out When 
Generating Contribution Statements  

The system runs slowly and eventually 
times out when the user tries to generate 
contribution statements. 

Changes were made to speed system 
performance when generating 
contribution statements. A timeout 
error no longer occurs. 

DIO-1045 Clear Button for the Datepicker 
Calendar Not Working 

The Clear button for the datepicker 
calendar does not remove selected dates 
from the Start and End Date fields on the  
Fund Management page. 

The Clear button for the datepicker 
calendar was fixed and now works  
as expected to remove selected dates.  

Administration DIO-1031 Merged Lookup Values for 
Religion Occasionally Not Updated in 
Member Details   

Lookup values for Religion that are merged 
by the diocese are sometimes not being 
updated in the Religion dropdown list in 
Member Details. 

After a Religion lookup value is 
merged, the Religion dropdown list in 
Member Details consistently reflects 
the change, and any record using 
merged values is updated accordingly. 

DIO-1036 Merge Family Queue Grid 
Contains Old, Failed Merge Records  

The Merge Family Queue grid is showing 
old, failed merges that have since been 
corrected and completed successfully. 

Old, failed merge records that have 
been successfully merged no longer 
appear in the Merge Family Queue 
grid. By default, records are now 
sorted in descending order on the 
Date Merge Created column so that 
the most recently processed merged 
records appear first. 
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Table 2. Issues Resolved in the v4.4.2.64 Update  

Module Issue Description Update 

Family Suite 

Family Directory CNFS-5717 The order in which the elements 
in a recipient’s name appear on member 
mailing labels is not desirable 

The recipient’s name on mailing labels 
appears in the following format, which is 
awkward and therefore not desirable: 
recipient’s title followed by the last name 
and then the first name.  

The recipient’s name on the member 
mailing label was modified and now 
appears in this standard format: 
recipient’s title (for example, Mr.) 
followed by the first name and then 
the last name. 

Offering CNFS-5762 The system generates a timeout 
error when attempting to load the Quick 
Entry Posting page  

Users in large organizations or in 
organizations attempting to process large 
batches are experiencing a timeout error 
when attempting to open the Quick Entry 
Posting page.  

Performance adjustments were  
made to enable the Quick Entry 
Posting page to load without 
generating a timeout error. 

CNFS-5776 System is not taking negative 
contributions into account when calculating 
contribution totals 

In the Contribution Statement report, 
negative contributions that do not have a 
positive contribution to offset them are not 
being subtracted from contribution totals 
when they should be. 

Negative contributions without an 
offsetting transaction to cancel them 
out are now included in the calculation 
of contribution totals. 

CNFS-5793 The system is not saving the 
user’s changes to the fund end date 

When the user saves an edit to the fund 
end date, the system appears to save the 
edit but does not. 

After the user clicks Save to submit a 
change to the fund end date, the 
system saves the change as expected. 
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Table 2. Issues Resolved in the v4.4.2.64 Update (continued) 

Module Issue Description Update 

Family Suite (continued) 

Diocesan Development DIO-1048 Export to PDF process overrides 
the user-specified font for body of statement 

When contribution statements are exported 
to PDF, the system is changing the user’s 
font selection for the body of statement to 
Times New Roman. 

The system now uses the font 
selected by the user for the body of 
statement text.  

Administration CNFS-5791 The system is very slow or times 
out when attempting to load the Merge 
Family Queue page 

When the user tries to open a Merge 
Family Queue page that contains a lot of 
data, the page is so slow to load that the 
system eventually times out.   

Performance adjustments were  
made to make the Merge Family 
Queue page to load faster without 
generating a timeout error. 
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Contacting ParishSOFT 
If you have questions or require support while using the application, use any of the following  
methods to contact us:  

 
http://www.parishsoft.com/getsupport 

 
support@parishsoft.com 

 
(734) 205-1000 (main) 
(866) 930-4774 (support) 
(734) 205-1011 (fax) 

 

http://www.parishsoft.com/getsupport

	Version 4.4.2 Release Notes
	ConnectNow Family Suite
	System-Wide
	Resolved Issues
	Various Typographical and Grammatical Errors Fixed


	Family Directory
	Updates and Enhancements
	Label Format Modified to Provide Space for Two Address Lines
	Organization Dropdown List Added to Family Details
	Label Format Modified to Provide Space for Two Address Lines
	Organization Dropdown List Added to Member Details
	Label Format Modified to Provide Space for Two Address Lines
	Label Format Modified to Provide Space for Two Address Lines
	Funeral Report Modified to Show the Married Name Instead of the Maiden Name

	Resolved Issues
	‘All Organizations’ Filter Applied to the Family List Now Shows One Record Per Family
	Recipient’s Name on Mailing Labels Corrected
	Middle Name Column Added to Reconciliation Prep Export File
	Merge Fields Added to Notation Page in the Baptism Templates
	CSV File Now Includes Records Selected in the Sacraments Grid
	Member’s Holy Orders Record Now Displays Expected Data
	Edit Workgroups Button No Longer Becomes Disabled After User Views Family Details
	Sacraments Reports Contains Multiple Entries for Certain Members


	Religious Education
	Updates and Enhancements
	Label Format Modified to Provide Space for Two Address Lines

	Resolved Issues
	Populated Registration Forms No Longer Include Names of Deceased Children
	Description of the ‘Copy Classes’ Option Modified for Accuracy


	Offering
	Updates and Enhancements
	Contributions and Pledges
	Label Format Modified to Provide Space for Two Address Lines


	Resolved Issues
	User Edits to the Fund End Date Now Saved As Expected
	Red Text Removed from Non-Error Message
	Intermittent Timeout Error for Quick Entry Batches Resolved
	Timeout Error Experienced When Attempting to Open the Quick Entry Posting Page Resolved
	Contributions
	E-Statements ‘Processing Request’ Error Fixed
	‘Include $0 Contributions’ Checkbox Works As Expected
	Member Option for E-Statement Generation Disabled
	Negative Contributions Now Include in Calculation of Contribution Totals



	Ministry Scheduler
	Updates and Enhancements
	Label Format Modified to Provide Space for Two Address Lines

	Resolved Issues
	Controls Added to Ensure Deceased Members Are Not Scheduled
	System No Longer Stuck on Loading Spinner on Reports Page in Chrome Browser


	Tuition
	Resolved Issues
	System Now Allows Users to Delete Invoices with No Associated Payments


	Diocesan Development
	Resolved Issues
	Donor Name Search Improved
	‘Timeout Expired’ Error Resolved
	User-Specified Font for Body of Statement Text No Longer Changed
	Transmission Errors Caused by Routing Numbers Starting with Zero Resolved
	Clear Button for the Datepicker Calendar Now Working As Expected


	IQ
	Resolved Issues
	Process for Creating a Family Workgroup from IQ Results Now Works As Expected
	Column Values Converted from Integer to Decimal Type
	Queries Against Secure Fields Now Working As Expected


	Administration
	Updates and Enhancements
	‘Foundation’ Option Added to Organization Type Dropdown List
	‘All’ Option Added to the Member Status Dropdown List in the Advanced Filter Group
	‘Show End-Dated Staff’ Filter Added to the Advanced Filter Group
	Format and Functionality of the Position Filter Modified
	Member DUID Information Added to the Member Search Modal
	Duplicate Member Records No Longer Appear in ‘Add New Staff’ Search Results Set
	Organization’s City Name Added to the Assignments Dropdown List
	Added Ability to Save Selected Advanced Filter Option As a Favorite
	Address Tab in Staff User’s Member Details Now Visible to Diocesan Administrators Only
	Text in Position Field Now Displayed As a Link If the Staff Member Holds Multiple Positions
	CSV Export File Now Shows Additional Positions Held by Staff
	Member and Family DUIDs Added to Merge Family Records Page

	Resolved Issues
	Member Lookup Table for Religion Now Updated As Expected with Merged Lookup Values
	Removing a User’s Giving History Permission Now Blocks Access to Family Giving History
	Filters Applied to Staff List No Longer Reset After the User Opens a Staff Record
	Assignment Shown in Primary Position Column Now Correct
	Organization Administrators Can Edit Any Organization to Which They Have Access Permissions



	Diocesan Suite
	Census
	Updates and Enhancements
	MLNA, ‘Do Not Call’, and ‘Do Not Solicit’ Checkbox Controls Added to the Family Record
	Diocesan Notes Section Added to the Notes Tab
	Church of Registration Field Converted to Dropdown List
	Secure Information Feature Added

	Resolved Issues
	Staff with Edit Permissions in an Organization Can Now Edit the Organization’s Data Externally
	Staff with Edit Permissions in Multiple Organizations Can Now Edit Unowned Member Records
	Family Workgroups Added in Desktop Family Directory Now Visible in ConnectNow
	‘Add Families’ Search Now Returns One Record Only
	‘Add Member’ Search Now Returns Owned Organization’s Member Records Only


	Diocesan Development
	Resolved Issues
	Trailing Commas in Lockbox 8 Import File No Longer Cause Failed Import
	Start and End Dates for a Fund No Longer Disappearing


	Administration
	Updates and Enhancements
	‘Unknown’ Option Added to Member Status Filter’s Dropdown List
	Format of the Position Filter on the Staff List Toolbar Changed
	Assignment Filter Added to Advanced Filter Group
	Setup Page for Secure Information Added
	Step 1: Enable the Secure Fields Feature
	Step 2. Creating Labels for Secure Information Fields
	Step 3: Give Diocesan Staff Permission to Access Secure Information

	Merge Family Queue Grid Updated
	Merge Family Records Process Updated to Enable Multiple Family Merges
	Merge Family Report Updated
	Reports Section Added
	Access Rights Export
	Clergy Summary Report


	Resolved Issues
	Organization Administrators Can Now Edit Any Organization to Which They Have Access
	System Now Saves Edits to a Staff User’s Member Details Record
	‘Clear Filter’ Button No Longer Disappears After the User Changes Organizations
	Old Failed Merge Records Removed from Merge Queue
	Timeout Error Experienced When Opening the Merge Family Queue Page Resolved



	Subsequent Updates to the 4.4.2 Release
	Contacting ParishSOFT

